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User	Guide	for	Cary	5000	spectrometer	with	
external	DRA	1800	attachment.	

(Last	updated	09/20/2021)	

This	guide	is	for	use	of	the	Cary	5000	with	the	external	diffuse	reflectance	accessory,	
DRA.		For	use	without	the	DRA	see	User	guide	for	Cary	5000	in	absorption	mode.	

Important	warnings!	
• Never	plug	or	unplug	the	external	DRA	electrical	attachment	when	the	

instrument	is	on.			
• Never	put	white	light	into	the	DRA	with	the	DRA	connected	to	the	Cary.	
• Do	not	use	Align	command.	
• Do	not	use	compressed	air	dusters	on	any	mirrors	or	optics.	
• Do	not	use	any	samples	that	can	fall	apart	in	the	integrating	sphere.	

Introduction	and	Help	
For	a	complete	guide	to	the	Cary	hardware	and	open	the	Cary	“Scan”	program	and	click	
on	the	Help	tab.	
Hardware:	Help	>	Help	topics	>	Accessories	>	Cary	4000/5000/6000i	>	Solid	Sample	>	
external	DRA		
Software	Help	>	Help	topics	>	Software	Applications	>	Scan	

Turning	the	instrument	on:	
The	DRA	must	be	fully	closed	for	the	instrument	to	initialize.	Turn	on	the	instrument	
(0/I	switch	on	the	lower	left	side	of	the	front	of	the	instrument).			

Open	the	Cary	Scan	program	on	the	taskbar	or	Desktop.		
In	the	Scan	program,	watch	the	lower	left	corner	to	see	the	status	of	the	instrument.	
When	the	traffic	light	is	green	the	Cary	is	ready	

.		If	there	is	an	error	message	see	Startup	Error	section	above.	

Integrating	Sphere	Configuration		
The	sample	can	be	placed	for	use	with	the	integrating	sphere	(see	figure	1	and	2)	at	four	
positions.	

1. The	entrance	to	the	integrating	sphere	is	for	normal	incidence	diffuse	transmission	
2. The	rear	slot	is	for	normal	incidence	diffuse	reflection	
3. The	center	mount	holder	allows	for	variable	angle	diffuse	transflectance	

measurements	
4. In	addition,	the	VATH	(variable	angle	transmission	holder)	accessory	can	be	put	in	

front	of	the	integrating	sphere	for	variable	angle	specular	transmission	
measurements.	If	you	would	like	to	use	the	VATH	accessory,	please	talk	to	one	of	the	
GLAs	for	the	instrument	first.			

Do not remove 
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Large	Sample	Setup		
For	Large	samples	one	must	remove	lens	2	(Figure	1)	and	use	the	large	sample	setup	
mirror	M3.	The	large	sample	standard	M3	mirror	(Figure	1)	has	three	sample	positions	
depending	on	where	the	sample	is	(Transmission,	Center,	and	Reflection).		Each	of	the	
mirror	positions	will	focus	the	light	onto	the	position	of	the	sample.		The	three	positions	
are	marked	T	(transmittance	slot),	C	(center	mount),	and	R	(rear	reflectance	slot)	in	
Figure	1.	Thus,	the	mirror	needs	to	be	moved	to	the	right	position	depending	on	the	
placement	of	your	sample.		The	cable	for	the	DRA	can	get	in	the	way	of	moving	this	
mirror.		Wear	gloves	to	handle	the	mirrors	or	lens.	Turn	off	the	Cary	first,	if	you	
need	to	unplug	the	DRA	to	move	the	mirror.		

Small	Sample	Setup	with	SSK	
The	M3	mirror	is	replaced	by	the	small	sample	kit	(SSK)mirror	(Figure	1)	in	the	T	
position.		Lens	(L2)	mounts	in	front	of	the	sample.		There	are	three	lenses	that	can	be	
used	at	the	L2	position	again	for	the	three	sample	positions	marked	as	T,	C	or	R.		
The	optics	need	to	be	aligned	every	time	you	start	and	experiment,	so	that	the	sample	
and	reference	beams	are	not	clipped	and	that	the	sample	beam	is	centered	on	the	
sample.		
1. Put	on	clean	gloves.	
2. Under	the	commands	menu	click	on	Go	to,	and	then	type	in	550	nm	(do	not	use	

the	“align”	option).		

Figure 1 Diffuse Reflectance Accessory showing optics and  beam path. 
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3. Darken	the	room	lights.	
4. With	a	thin	white	card,	you	should	see	a	green	spot	at	your	sample	position.	(If	you	

cannot	see	the	beam:	Block	both	
sample	and	reference	beams	from	
entering	the	integrating	sphere.	Then	
under	the	commands	menu	choose	
align	to	switch	the	gratings	to	zero	
order	to	send	white	light	into	the	
DRA.		The	white	light	must	not	
enter	the	integrating	sphere,	or	it	
will	damage	it!!)	

5. Check	that	the	beam	hits	the	center	
of	the	M3	mirror	and	goes	through	
the	center	of	L2	and	hits	the	center	of	
your	sample.	

6. Most	of	the	mirrors	have	two	knobs,	
which	you	can	rotate	to	adjust	the	
vertical	and	horizontal	positions	of	
the	beam.	

7. If	your	sample	will	be	at	the	
reflectance	port,	use	mirror	M1	to	
make	the	light	beam	go	through	the	
center	of	the	entrance	to	the	sphere,	
then	use	M3	to	make	the	beam	hit	
your	sample.	Redo	this	several	times	until	the	beam	does	both	at	once.	

8. If	your	sample	will	be	at	the	transmittance	port,	use	mirror	M1	to	make	the	light	go	
through	the	center	of	M3	and	lens	L2,	then	use	M3	to	hit	your	sample.		Redo	do	this	
several	times	until	the	beam	does	both	at	once.	

9. Check	that	the	sample	beam	does	not	overfill	your	sample	or	hit	any	white	surfaces.	
If	the	sample	is	small	you	need	to	mask	the	sample	and/or	use	an	aperture	to	
restrict	the	entrance	to	the	integrating	sphere	(look	in	the	drawers	for	the	Cary	for	
apertures).	You	can	also	reduce	the	slit	height	in	the	software	or	close	the	
iris/aperture	in	the	sample	compartment	(Figure	1	&	2).	Do	not	put	anything	that	
can	scatter	light	close	to	the	beam	path	at	the	entrance	or	exit	to	the	sphere.	This	
includes	edges	of	glass	slides.	

10. If	you	have	very	small	samples,	see	the	small	sample	kit	in	the	Users	Guide	below	for	
more	suggestions	on	small	samples	

11. Check	that	the	reference	beam	hits	mirrors	M4	and	M5	close	to	the	center	and	goes	
through	the	center	of	L1	and	is	not	clipped	at	the	entrance	of	the	reference	beam	
into	the	integrating	sphere.	Use	mirror	M5	to	center	it	on	the	entrance.	

12. 		Do	not	adjust	the	mirrors	with	no	knobs.		If	they	need	adjustment	call	the	GLA,	
usually	they	do	not	need	adjustment	

Running	your	Sample	
1. Select	Setup	→	Instrument	Settings	→	Cary	Options	

Figure	2	Photo	of	diffuse	reflectance	accessory	with	beam	
path.	
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a. Set	the		wavelength	range,	and	the	Y	mode,	%T,	Abs,	or	%R	
b. Set	the	Ave	time	(time/data	point)	as	0.1	s	and	a	Data	interval	of	1	nm	if	your	

measurements	will	show	significant	changes	(if	you	have	small	intensities	or	
small	changes,	you	may	consider	using	an	Ave	time	of	0.5	or	1	and	a	Data	interval	

of	2	nm/point.		
c. Under	Advanced	Settings	set	SBW,	to	2	nm,	and	Detector	and	Grating	change	

wavelengths.	(Again,	if	you	signals	are	small	you	can	set	the	SBW	to	4	nm,	but	it	
will	increase	the	beam	width	and	may	overfill	you	sample).	

d. Under	Baseline	tab:	chose	zero/baseline	correction	
e. Under	File	Storage	tab:	set	whether	it	prompts	to	save	the	spectrum.	
f. Then	click	Ok	to	close	the	Instrument	Settings	window.	
g. Note	that	the	signal	to	noise	ratio,	S/N,	is	a	function	of	the	amount	of	light	that	

reaches	the	detector.		Increasing	the	SBW	by	a	factor	of	2	will	increase	the	light	to	
the	detector	by	4.		Decreasing	the	slight	height	to	reduced	will	decrease	the	light	
by	4.		Increase	the	Abe	time	by	a	factor	of	2	will	decrease	S/N	by	√2.	A	setting	of	
SBW=4	nm	and	reduced	slight	height	give	an	approximately	square	spot	on	the	
sample.	

2. Check	that	all	exits	of	the	integrating	sphere	are	blocked	with	full	reflectors.		
3. You	need	to	run	the	100%	Baseline	correction	with	everything	in	the	beam	path	

except	your	sample.	If	using	an	aperture	for	reflection	or	transmission	
measurements,	please	see	the	“Aperture	kit	for	small	samples”	in	the	User	Guide	
below.			

4. Choose	Baseline	and	run	100%	T	(or	R)	scan,	then	block	the	sample	beam	at	the	
entrance	to	the	integrating	sphere	for	the	0%	scan.		

5. It	is	good	practice	to	run	a	spectrum	with	no	sample	after	running	Baseline	to	make	
sure	that	you	have	a	good	100%	T	line.	

6. Note	that	the	signal	to	noise	(S/N)of	your	sample	spectrum	can	be	no	better	than	
the	S/N	of	your	baselines	and	will	likely	be	worse	by	a	factor	of	about	
1.4	to	2.	

7. Mount	your	sample	
8. Choose	Start	to	run	the	spectrum 	
9. If	you	have	small	intensities	(low	%	R	or	T)	use	longer	time/point	and	

SBW	settings	to	reduce	noise.	However,	if	you	increase	SBW	you	
increase	the	light	beam	size	and	so	need	to	check	if	the	beam	overfills	
your	sample.	

10. Notes:	
a. The	S/N	will	increase	if	the	SBW	is	increased,	if	the	slit	height	is	set	to	full,	or	

if	the	Ave	time	(time/point)	is	increased.	
b. The	time	to	run	the	spectra	will	decrease	if	the	Ave	time	is	decrease	or	if	the	

Data	interval	is	increase.	
c. Since	the	SBW	setting	in	the	IR	is	not	used	and	the	instrument	uses	the	

energy	mode	the	S/N	in	the	IR	is	usually	very	good.	

Start	
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ToolBar	

	
Small	Sample	Considerations	
Most	typical	lab	samples	are	smaller	in	size	than	what	the	instrument	was	designed	to	
measure.		For	all	three	types	of	measurements	(T,	C,	and	R),	it	is	best	to	under	fill	the	
sample	so	that	no	light	goes	around	the	sample.	

Spot	size	-	There	are	two	ways	of	reducing	the	beam	spot	size:	
1. In	the	Setup:	options	tab,	change	the	slit	width	and	height	

a. Slit	width:	You	can	narrow	the	slit	width	by	changing	the	SBW	parameter.			
b. Slit	height:	Under	slit	height,	switch	to	Reduced.		It	takes	about	a	minute	for	

the	slit	to	change.	
2. Small	spot	kit	(SSK):	There	are	a	series	of	lenses	and	a	mirror	that	can	be	put	in	

the	optical	path	to	focus	the	beam	into	a	smaller	spot	on	the	sample.		The	large	
mirror	(M3)	must	be	changed	to	the	SSK	mirror.	The	SSK	mirror	is	always	kept	
in	the	T	position.	There	are	three	lenses		(L2,	Figure	1)	with	different	focal	
lengths	and	marked	T,	C,	and	R	for	the	three	positions	of	the	integrating	sphere.		

3. There	are	aperture	kits	that	can	used	with	the	SSK	to	adapt	a	small	sample	
to	the	beam	
a. Transmission	measurements	Aperture	kit		:	There	are	apertures	in	the	

drawer	for	the	Cary	used	for	transmission	measurements.		They	can	be	used	
on	the	entrance	slit	with	the	white	spectralon	facing	toward	the	integrating	
sphere.		You	ideally	would	like	the	sample	to	completely	fill	the	hole	in	the	
aperture	and	the	sample	light	beam	to	be	about	the	same	size	as	the	aperture.		
If	the	sample	is	smaller	than	the	hole	in	the	aperture	you	need	to	mask	the	
sample	with	black	tape.	

b. Reflection	measurements	Aperture	kit	:	For	normal	incidence	reflection	
measurements,	the	port	at	the	rear	of	the	integration	sphere	is	several	inches	
in	diameter.	A	series	of	apertures	can	be	used,	which	have	the	white	
Spectralon	material	on	the	side	that	faces	toward	light	beam.		The	spring-
loaded	mount	that	holds	the	sample	against	the	integrating	sphere	needs	to	be	
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taken	off.		Slide	on	the	appropriate	aperture	(you	can	use	a	little	tape	to	hold	it	
in	place)	then	put	the	spring-loaded	sample	mount	back	on.	
It	is	best	if	the	beam	spot	does	not	overfill	the	aperture.		If	the	beam	overfills	
the	aperture,	you	can	reduce	the	beam	size	as	mentioned	in	1	above	or	by	
using	an	aperture	on	the	entrance	to	the	integrating	sphere	or	closing	the	
aperture/iris	S1	(Figure	1	&	2).	If	the	beam	spot	overfills	the	aperture	a	little,	
you	can	correct	for	this	“stray	light”	by	performing	a	Zero/baseline	
Correction.		Normally,	the	0%T	Baseline	scan	is	run	by	blocking	the	beam	
before	it	enters	the	integrating	sphere,	which	accounts	for	electronic	noise.		
To	correct	for	slight	overfilling,	do	not	block	the	beam	and	if	doing	reflectance	
leave	the	exit	port	open	(but	with	the	aperture	in	place)	so	that	the	0%T	
Baseline	will	see	light	that	hits	the	aperture).	This	is	only	useful	if	the	
refection	from	the	sample	is	significantly	stronger	then	the	light	that	hits	the	
exit	aperture.	One	can	check	the	amount	of	light	hitting	the	apperature	by	
runing	a	spectrum	with	the	sample	light	blocked	at	the	entrence	slit.		It	is	best	
if	you	can	control	the	beam	size	so	that	only	the	sample	is	illuminated.	

Performing	a	Zero/Baseline	Correction:	Select	this	option	zero/baseline	
correction,	to	apply	both	a	100%T	baseline	correction	and	a	zero-line	correction	to	
the	sample	scan.	This	correction	is	performed	with	the	raw	transmission	data	and	is	
given	by:	

𝑅! − 𝑅"%$%&'()*'
𝑅+""%,$%&'()*' − 𝑅"%,$%&'()*'

	

Where	RS,	R0%Baseline,	and	R100%Baseline	are	the	ratios	of	the	light	intensity	coming	in	the	
sample	port	to	that	coming	in	the	reference	port	for	than	there	is	a	sample,	the	
sample	beam	is	blocked	and	when	there	is	no	sample,	respectively.		With	this	option,	
the	Cary	will	prompt	you	to	perform	a	100%TBaseline	first,	followed	by	a	
0%TBaseline	when	you	perform	a	baseline	collection.	

Basics	of	measurement	configuration	
The	wavelength	range	possible	is	from	250	to	1800	nm.	Scans	normally	go	from	long	to	
short	wavelengths.		There	are	two	detectors,	a	PMT	and	an	InGaAs.		The	wavelength	at	
which	the	system	changes	from	one	to	the	other	(accompanied	by	a	grating	change)	can	
be	adjusted.		Usually,	800	±	50	nm	is	a	good	value	for	this	change	over.		You	can	see	the	
change	in	the	spectrum	when	you	take	a	baseline	(%	Transmission	or	Reflection).		If	
you	see	a	step	in	the	spectrum,	it	may	mean	your	baseline	is	bad	or	that	your	sample	
has	a	polarization	dependency.		

Setup	–	The	setup	button	located	in	the	upper	left-hand	corner	defines	the	scan	
parameters.		The	following	useful	tabs	can	be	found	under	Setup.		

Instrument	Setting:	Cary	Options:	Here	you	can	set	the	Wavelength	Range,	the	x-
and	y	axes	units	(nm,	cm-1,	etc.	and	A,	%T,	%R,	etc.),	as	well	as	the	axes	ranges.		
Under	scan	controls,	the	average	time	per	data	point	and	the	data	interval	can	be	
set.		Note	that	the	Scan	Rate	will	be	automatically	determined	from	these	values.	
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Note	if	taking	a	low	light	spectrum	longer	time	per	data	point	will	yield	a	better	
spectrum.	
Instrument	Setting:	Advanced	Settings:	Here	you	control	the	Beam	Mode,	
Spectral	Band	Width	(SBW),	and	Slit	Height	(see	Appendix	below	for	more	info).		The	
Double	beam	mode	needs	to	be	used	for	the	integrating	sphere	measurements	and	
the	SBW	is	typically	set	to	2	nm.		

The	Slit	Height	can	be	used	to	decrease	the	beam	spot	size	normally	it	is	set	to	full.	
Typically,	the	UV-Vis	button	will	be	selected.		If	you	do	not	need	to	go	to	shorter	
wavelengths	than	400	nm,	you	can	select	the	Vis	button,	which	will	turn	off	the	UV	
lamp.				
Instrument	Setting:	Baseline:	Sets	the	type	of	baseline(s)	corrections	used	in	the	
Scan.	The	different	types	of	baseline	corrections	are	useful	with	some	accessories.	
You	should	collect	a	zero/baseline	correction	immediately	before	scanning	a	sample	
after	the	instrument	has	warmed	up	for	>	20	minutes	using	the	same	scan	
parameters	that	you	will	use	for	your	sample	Also	a	stored	baseline	can	be	used.	
The	Cary	WinUV	system	collects	a	new	baseline	when	you	select	any	type	of	
baseline	correction	in	the	Baseline	tab	of	the	Setup	dialog	box	and	then	click	
Baseline	button	in	the	application	window.	Depending	on	the	type	of	correction	you	
have	selected,	the	Cary	will	prompt	you	to	a	100%Tbaseline	(for	the	DRA	with	the	
100%	reference	material	in	the	sample	positions	and,	,	a	0%Tbaseline	(with	the	
sample	beam	blocked)	if	a	zero/baseline	correction	was	chosen.	

Once	the	baselines	have	been	collected,	they	will	be	automatically	applied	to	each	
collected	sample	data	point	as	it	is	displayed	(indicated	by	the	red	display).	The	
correction	applied	is	shown	below	in	the	Appendix	B.		
A	baseline	cannot	be	applied	to	a	sample	where	the	wavelength	range	of	the	sample	
exceeds	that	of	the	baseline.	If	you	change	your	wavelength	range	to	one	outside	
that	of	the	baseline,	the	Cary	will	display	an	error	message.	Also,	the	red	text	in	the	
ordinate	(y)	display,	which	indicates	that	the	baseline	correction	mode	is	activated	
will	disappear.	

See	Appendix	B	for	more	info	on	the	acquisition,	storing,	and	retrieval	of	baseline	files	

Instrument	Setting:	Independent	UV-Vis:	This	is	normally	not	changed	from	
default	Auto	in	Measurement	Mode.		In	this	mode	the	instrument	will	collect	
double	beam	spectra	using	a	fixed	SBW	in	the	UV-Vis	region	and	a	fixed	energy	or	
detector	gain	in	the	NIR	region.	In	this	mode,	you	must	set	a	SBW	value	for	the	UV-
Vis	region.		The	normal	setting	is	2.00	nm.	You	will	find	that	the	gain	to	the	detector	
(Energy	level)	will	change	automatically	to	maintain	the	required	signal	level.		
You	can	explicitly	set	how	the	instrument	controls	the	detector	readings	in	each	
region.	If	you	want	the	instrument	to	scan	in	another	mode	i.e.,	fixe	SBE	in	the	NIR	
or	fixed	energy	(gain)	in	the	UV-Vis	region	you	can	set	that	here,	see	Appendix	A	for	
details.	
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File	Storage:	The	Auto	Store	tab	allows	you	to	specify	if	you	want	to	be	prompted	to	
store	the	collected	data.	You	can	store	the	data	in	a	Batch	or	Data	file	at	the	start	or	
end	of	a	collection.	If	you	set	Storage	Off	you	will	need	to	manually	store	your	
unsaved	data	after	the	run	is	complete.		
Note:	In	the	Scan	application,	Prompt	at	Start	and	Prompt	at	End	saves	the	
spectrum	as	a	data	file	(*.DSW)	unless	there	are	multi	or	cycle	scans	being	
performed.		

Commands	In	the	Menu	Bar:	Commands	can	be	accessed	both	from	the	
menu	items	at	the	top	of	the	main	window	and	from	the	application	buttons	on	the	
right-hand	side	of	the	screen.	Alternatively,	you	can	use	function	key	shortcuts	for	some	
of	the	commands.	These	appear	next	to	the	item	in	the	Commands	menu.		

Start:	Start	a	Scan	using	current	set	up	parameters.	Function	key	is	F9.		

Stop:	Stop	a	Scan.	If	you	have	selected	Storage	On	in	the	Auto	Store	tab,	all	data	
collected	is	automatically	stored	in	the	file	specified	in	the	Batch	name	field	of	the	
Save	window.	Function	key	is	F12.		
Connect:	The	Connect	command	becomes	available	when	more	than	one	software	
application	is	running	at	any	one	time.	The	application	that	is	in	use	will	be	online	
and	will	control	the	Cary.	All	other	applications	will	be	offline	and	display	the	
Connect	command.	If	you	wish	to	swap	to	a	different	application	(and	still	keep	
other	applications	running)	you	will	need	to	select	Connect	in	the	application	you	
wish	to	connect	to	the	Cary.		
Zero:	Best	never	to	use	this.	Zeros	the	current	ordinate	value	using	the	Start	
wavelength	(or	equivalent)	value	set	in	the	Setup	dialog	box.	Function	key	is	F5.	Do	
not	use	this	if	you	sample	is	not	zero	at	this	wavelength.	
Goto:	Moves	the	monochromator	to	a	wavelength	specified.	Function	key	is	F4.	Only	
available	if	the	instrument	is	not	currently	collecting	data.	
Align:		Moves	the	Cary	spectrophotometer	to	white	light	(0	nm).	Only	use	if	both	
sample	and	reference	slits	to	integrating	sphere	are	blocked.	You	can	then	use	
this	light	for	aligning	accessories	
Lamps	Off:	Switches	off	all	lamps.	

Lamps	On:		Switch	on	selected	lamps.	

Graph	menu:	The	Graph	menu	allows	you	to	view	data	in	various	graphical	
formats	or	in	multiple	graphs	in	the	Graphics	area.	You	can	double-click	on	the	Graphics	
area	to	toggle	the	display.	The	graph	functions	can	also	be	accessed	by	clicking	one	of	
the	Toolbar	buttons	or	right-clicking	in	a	graph	box	or	the	Graphics	area.	Not	all	
functions	are	available	on	every	menu.		

Red	Spectrum:	The	red	spectrum	in	any	graph	box	is	the	focus	spectrum,	the	one	
for	which	all	information	appears	and	the	one	used	for	cursor	tracking.	If	you	hold	
the	cursor	over	a	trace,	bubble	text	identifying	the	trace	is	shown.	
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Trace	Preferences:	Use	to	choose	the	trace(s)	to	display	in	the	selected	spectrum.	

Graph	Preferences:	Use	to	change	the	appearance	of	your	graph.		
See	Appendix	C	for	more	option	under	the	Graph	menu	as	well	as	the	Trace	Preferences	
and	Graph	Preferences	menus	

Storing	Data	
Under	the	File	menu	you	can	save	your	Method	(the	Setup	configuration	used	to	
perform	the	scan),	your	Data,	or	the	combination	of	the	Method	and	Data	as	a	Batch	file.			

File,	Save	Method	As:		Used	to	store	the	current	method.	You	can	store	the	method,	
data,	report,	or	graphics	template	separately	or	together	as	a	Batch	file.	The	data	can	
also	be	saved	as	a	Cary	GRAMS	file,	a	comma	delimited	ASCII	spreadsheet	file	or	in	
formats	suitable	for	other	Cary	software	systems	(depends	on	which	application	you	
are	running).		

File,	Save	Data	As:	Used	to	store	the	collected	data.	You	can	store	the	method,	data,	
or	report	separately	or	together	as	a	Batch	file.	The	data	can	also	be	saved	as	a	Cary	
GRAMS	file,	a	comma	delimited	ASCII	spreadsheet	file	or	in	formats	suitable	for	
other	Cary	software	systems	(depends	on	which	application	you	are	running).		After	
a	batch	file	has	been	saved,	you	can	use	this	option	to	manually	save	the	file	as	a	
method	file,	a	batch	file,	a	comma	delimited	ASCII	spreadsheet	file	or	a	Rich	Text	
Format	file.	

How	to	Export	Collected	Data	
If	you	want	to	export	data	from	a	Cary	WinUV	application	into	a	third-party	
application,	then	save	your	data	as	an	ASCII	*.CSV	file.	To	do	this:	

1. Click	File	→	Save	Data	As.		
2. Click	the	down	arrow	next	to	the	Files	of	type	list	box.		
3. Select	Spreadsheet	ASCII	(*.CSV).		
4. Type	your	file	name	into	the	File	name	field	and	click	save.		

How	to	Combine	Data	Files	into	a	Batch	File:	
If	you	have	several	data	files	that	you	need	to	combine	into	a	batch	file,	then	you	
need	to:	

1. Select	Open	Data.		
2. .	Click	the	down	arrow	at	the	right	of	the	“Files	of	Type”	list	box	and	select	

'Data'	to	list	all	the	data	files.		

3. Check	the	Overlay	Data	check	box.		
4. Highlight	the	data	files	that	you	require	and	click	Open.	The	highlighted	data	

files	will	load	into	the	application	and	appear	in	the	same	graph	box.		

5. Select	File	→	Save	Data	As.		
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6. A	list	of	previously	stored	data	files	will	appear.	Click	the	down	arrow	at	the	
right	of	the	“Files	of	Type”	list	box	and	select	'Batch'	to	list	all	the	batch	files.		

7. Make	sure	that	the	Save	only	focused	trace	check	box	is	not	checked.		
8. In	the	File	name	field,	type	in	the	file	name	for	your	new	batch	file.		
9. Click	Save	to	create	the	new	batch	file.	The	current	method	will	be	stored	with	

the	batch	files.	All	the	data	files	are	now	combined	into	the	one	batch	file.	

Error	on	Startup	
1. Click	ok	and	let	the	Cary	continue	the	initialization	process.	
2. Go	to	the	Commands:GoTo	menu	option	to	go	to	500	nm.	
3. Check	that	the	small	aperture	in	the	sample	light	path	is	all	the	way	open.	
4. Check	that	there	is	no	sample	on	any	of	the	ports	or	inside	the	integrating	sphere.	
5. Turn	the	room	lights	off.		Check	that	the	sample	green	light	beam	comes	out	of	the	

sample	monochromator	window	and	goes	into	the	integrating	sphere.	Check	the	
reference	beam	in	the	same	way	(Figure	2).		

6. If	you	don’t	see	any	light	coming	out	of	the	monochromator	
a. 	go	back	and	use	the	GoTo	command	again	and	wait	until	it	completes	before	

opening	the	instrument.	
b. Check	that	there	is	nothing	blocking	the	light	from	entering	integrating	

sphere.	
7. Close	the	sample	compartment	on	the	Cary	and	make	sure	you	hear	the	interlock	

click.	
8. Turn	off	the	Cary,	wait	10	s,	and	then	turn	the	Cary	back	on.		It	should	now	startup	

correctly.	

Appendix	A	
How	the	Cary	5000/6000i	Controls	SBW	and	Energy	
In	a	spectrometer	the	intensity	observed	by	the	detector	changes	with	wavelength.	
Double	beam	spectrometers	can	monitor	the	detector	readings	to	make	sure	that	they	
stay	within	their	optimum	region.		This	can	be	done	in	two	ways.		You	can	open	and	
close	the	slits	to	increase	or	decrease	the	amount	of	light	that	reaches	the	detector,	or	
you	can	change	the	gain	on	the	detector	to	
increase	or	decrease	the	reading.		In	the	
former	mode	the	spectral	band	width	
(SBW)	will	change	as	the	slits	open	and	
close.		To	prevent	changes	in	the	SBW	with	
wavelength	the	latter	method	of	changing	
the	gain	is	used.	However,	the	SBW	is	in	
wavelength	(nm)	units	while	the	spectrum	
is	more	linear	in	energy	units	(cm-1)	so	
even	with	a	constant	SBW	the	band	width	
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in	energy	will	change	across	the	wavelength	range	(see	figure).	

In	the	UV-Vis	region	the	detector	is	a	photomultiplier	tube	(PMT)	that	allows	a	large	
change	in	gain	with	applied	voltage.		However,	in	the	NIR	region,	where	PbS	detectors	
were	traditionally	used	this	was	not	possible.		Thus,	the	SBW	was	normally	allowed	to	
vary	to	maintain	the	detector	output.	In	the	Cary	5000	an	InGaAs	detector	is	used	that	
has	very	low	noise	so	that	an	amplifier	with	settable	gain	can	be	used	to	boost	the	
signal.	
In	Double	or	Double	Reverse	Beam	Mode	in	the	UV-Vis	region	the	slit	width	(SBW)	is	
normally	kept	constant,	and	the	gain	of	the	detector	is	changed.	In	the	NIR	region	
(InGaAs	detector)	the	reverse	is	normally	true	i.e.	the	Energy	level	is	constant	and	the		
SBW	(slits)	changes.	Due	to	the	inherent	differences	between	the	two	types	of	detector,	
the	different	methods	of	control	normally	ensure	the	widest	dynamic	range	and	the	
best	signal	to	noise.	However,	in	the	experimental	setup	window	the	mode	used	can	be	
controlled	in	all	regions	(see	below).	
The	instrument	uses	two	detectors	(PMT	and	InGaAs	diode),	two	light	sources	(W	bulb	
and	D2	lamp),	two	gratings	in	the	monochromator,	and	five	order	sorting	filters.		You	
can	set	the	wavelength	at	which	the	detectors	and	gratings	change.		Both	of	these	are	
typically	set	at	800	nm,	if	you	have	an	important	spectroscopic	feature	at	800	nm,	you	
can	move	the	change	over	±	50	nm.		The	lamp	changeover	is	normally	set	to	350	nm	but	
again	can	be	moved	±	50	nm	
Note	Since	gratings	are	used	to	disperse	the	light	2nd	(and	3rd	)	order	light	from	the	
output	beam	(i.e.,	at	800	nm	you	would	also	get	400	and	200	nm	light)	would	reach	the	
detector.		The	filters	changes	are	at	350,	570,	800,	and	1200	nm.		You	cannot	move	
their	changeover	wavelengths.	
If	collecting	data	in	double	beam	mode	in	the	UV-Vis	regions,	you	can	set	how	the	
instrument	controls	the	detector	readings.		In	SETUP	under	the	independent	tab	if	you	
choose	how	the	double	beam	spectra	are	collected.	With	either	Auto	or	Fixed	SBW	set	
as	the	Measurement	Mode,	you	set	SBW	(slit	bandwidth)	value	in	the	UV-Vis	group.		
The	normal	setting	is	2.00	nm.		You	will	find	that	the	Energy	level	will	change	
automatically	to	maintain	the	required	signal	level.		
In	double	beam	mode	in	the	NIR	region	(where	the	detector	change	wavelength	occurs,	
generally	l >	800nm),	in	either	Auto	or	Fixed	Energy	Measurement	Mode,	the	Energy	
level	is	kept	constant	by	changing	the	slit	width	(SBW)	in	the	NIR.	An	Energy	setting	of	
1.0	will	provide	the	best	signal-to-noise	ratio	but	with	a	larger	SBW.		In	most	cases,	the	
recommended	setting	is	3.0;	this	provides	a	smaller	SBW	over	the	entire	region	and	a	
better	match	of	the	SBW	in	the	NIR	region	and	the	Vis	region.	You	will	find	that	the	SBW	
will	change	automatically	to	maintain	the	required	signal	level.		
In	double	beam	mode	across	the	UV-Vis	and	NIR	regions	with	Fixed	SBW	set	as	the	
Measurement	Mode	then	you	will	need	to	enter	values	in	the	SBW	fields	in	both	the	UV-
Vis	and	the	NIR	group	boxes.	The	values	can	be	the	same	if	you	want	to	use	the	same	
SBW	across	the	whole	scan	or	you	can	set	different	values	for	each	region,	normally	the	
SBW	in	the	NIR	is	>>	then	the	SBW	in	the	UV-Vis.	
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Note	that	the	SBW	is	in	nm	and	for	a	fixed	setting	of	the	SBW	the	resolution	in	energy	
terms	will	be	much	better	in	the	NIR	then	in	the	UV	or	Vis	regions	(see	figure).		A	
spectral	band	width	of	2	nm	at	400	nm	corresponds	to	124	cm-1	while	at	1200	nm	124	
cm-1	give	a	SBW	of	about	18	nm.		This	is	one	reason	that	most	absorption	peaks	in	the	
NIR	are	much	broader	in	wavelength	then	peaks	in	the	UV-Vis	regions.	It	also	suggests	
that	you	can	collect	at	a	wider	SBW	in	the	NIR	than	the	visible	regions.	

Appendix	B:		
Acquiring,	storing,	and	retrieving	baseline	files	
The	Cary	WinUV	system	collects	a	new	baseline	when	you	select	any	type	of	baseline	
correction	in	the	Baseline	tab	of	the	Setup	dialog	box	and	then	click	the	Baseline	button	
in	the	application	window.	The	then	Cary	prompts	to	perform	a	100%Tbaseline	(with	
nothing	in	the	beam,	or	in	the	case	of	a	Diffuse	or	Specular	Reflectance	measurements,	
with	the	100%	reference	material	in	position).	If	required,	you	are	prompted	for	a	
0%Tbaseline	(the	sample	beam	totally	blocked	so	that	the	instrument	can	measure	the	
electronic	zero	values).	
Once	collected,	they	are	applied	to	each	collected	spectrum.	If	there	is	no	corresponding	
data	point	in	the	current	baseline,	an	interpolated	point	is	used.	The	correction	applied	
to	each	point	is	shown	below		

A	baseline	correction	cannot	be	applied	if	the	Y	range	of	the	spectra	exceeds	the	100%	
baseline.	If	you	change	your	abscissa	range	to	outside	that	of	the	baseline,	the	Cary	
displays	an	error	message	and,	the	red	text	in	the	ordinate	display	which	indicates	that	
baseline	correction	mode	is	activated	will	disappear.	
All	values	within	the	Baseline	abscissa	range	are	corrected,	even	the	value	displayed	
while	the	Cary	is	idling	at	a	particular	wavelength.	
Note	
	Parameters	for	Energy,	SBW,	Beam	Mode,	Source	Changeover,	Detector	Changeover	

Grating	Changeover,	Selected	Lamp	for	the	collection,	Signal-to-Noise	Mode,	Slit	height	
and	the	Independent	Control	need	to	be	the	same	in	the	baseline	file	and	the	samples	
files	for	a	valid	correction.	

Baselines	are	saved	as	a	part	of	a	batch	file.	However,	if	you	want,	you	can	also	store	the	
baselines	by	themselves	in	a	baseline	file	without	the	collected	data.	To	do	this	you	
simply	select	the	Baseline	(*.CSW)	as	the	Save	As	Type	in	the	Save	As	window	accessed	
from	the	File	|	Save	Data	As	menu.	When	you	want	to	use	the	baselines	for	another	Scan	
run,	you	simply	open	the	file	using	either	the	File	|	Open	Data	command	or	click	the	
Baseline	button	in	the	Baseline	tab	of	the	Setup	dialog	box.	

	 Notes		
a. If	you	collect	a	new	baseline,	the	Cary	will	use	the	new	baseline	in	all	

corrections.	However,	the	Baseline	tab	will	still	display	the	name	of	the	
baseline	in	the	baseline	file.	You	need	to	save	the	collected	data	as	a	batch	file	if	
you	want	the	new	baseline	included	in	that	file.		
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b. All	corrections	are	performed	with	the	raw	transmission	data	that	comes	
directly	from	the	instrument.	These	transmission	values	are	then	converted	
into	the	selected	Y	mode	for	display.	

c. A	baseline	cannot	be	applied	to	a	sample	where	the	abscissa	range	of	the	
sample	exceeds	that	of	the	baseline.	If	you	wish	to	use	that	baseline,	then	you	
will	need	to	reduce	the	range	of	the	scan	by	changing	the	Start	and	Stop	fields	
on	the	Cary	tab	of	the	Setup	dialog	box	

Types	of	baselines.	Choose	the	type	of	baseline	correction	under	the	Baseline	tab	in	
the	Setup	menu	

Baseline	Correction:	A	100%	only	baseline	correction	is	applied	to	the	sample	scan,		
𝑅-

𝑅+""%./012341
	

Where	RS,	and	R100%Baseline		are	the	ratio	of	the	sample	beam	to	the	reference	beam	with	
and	without	the	sample.	
Zero/Baseline	Correction:	Both	a	100%T	baseline	correction	\and	a	zero-line	
correction		is	applied	to	the	sample	scan.		

𝑅! − 𝑅"%$%&'()*'
𝑅+""%,$%&'()*' − 𝑅"%,$%&'()*'

	

With	this	option,	the	Cary	will	prompt	you	to	perform	a	100%TBaseline	first,	followed	
by	a	0%TBaseline	when	you	perform	a	baseline	collection.	

This	baseline	option	corrects	for	any	inherent	variations	in	the	electronic	zero	line	of	
the	instrument.	Use	this	baseline	option	if	your	samples	have	areas	of	very	low	
transmission	or	reflectance	as	variations	in	the	instrument's	zero	line	will	affect	your	
measurements.	You	should	refer	to	ASTM	method	E903	for	further	details.	
Zero	SRA	correction:	Applies	a	100	%T	baseline	correction	and	a	zero-line	correction		
to	a	sample	measured	with	an	Absolute	VW	Specular	Reflectance	Accessory	(SRA).		

$
𝑅! − 𝑅"%,$%&'()*'

𝑅+""%,$%&'()*' − 𝑅"%,$%&'()*'
	

Note:	The	VN	SRA	and	the	single	bounce	relative	SRA	accessories	should	not	use	
this	correction.	Select	a	Baseline/Zero	correction	instead.	Refer	to	ASTM	method	
E903	for	further	details	

Zero	*Std.	Ref.	Correction:	Applies	a	100	%T	baseline	correction	and	a	zero-line	
correction		to	a	sample	measured	with	a	reflectance	accessory	which	is	not	absolute	
(e.g.,	a	Diffuse	Reflectance	Accessory	or	the	Variable	Angle	Specular	Reflectance	
accessory).	The	Cary	then	multiplies	the	result	by	the	appropriate	value	in	the	‘Baseline	
Stdref’	file	which	are	the	transmission	values	associated	with	the	Standard	Reference	
material	you	used	to	establish	the	baseline.	Refer	to	the	help	for	the	Diffuse	Reflectance	
accessories	for	further	details	about	Standard	Reference	materials.	
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%
𝑅! − 𝑅"%,5%&'()*'

𝑅+""%,5%&'()*' − 𝑅"%,5%&'()*'
& (Baseline	Stdref)	

Note:	If	you	select	this	option	the	Baseline	button	in	the	main	window	will	not	be	
enabled	until	you	have	retrieved	a	Std	Ref	file.	Click	this	button	to	browse	for	and	
select	a	Std	Ref	file.	This	file	must	be	in	the		correct	format	

Known	Mirror:	Used	for	a	VW	Specular	Reflectance	Accessory	(SRA)	with	a	small	
sample	or	a	sample	of	low	reflectance.	Refer	to	your	SRA	manual	for	more	information.	
Uses:	

% 𝑅! − 𝑅"%,$%&'()*'
𝑅+""%,$%&'()*' − 𝑅"%,$%&'()*'

&

Known	mirror	corrected 	

where	

Known	mirror	corrected = $%
𝑅6)7787 − 𝑅"%,$%&'()*'

𝑅+""%,$%&'()*' − 𝑅"%,$%&'()*'
&	

Tip	If	baseline	correction	is	activated,	the	type	of	correction	that	the	Cary	will	apply	
will	appear	in	the	in	red.		However,	sometimes	you	may	notice	that	the	text	has	
turned	to	gray	and	is	in	italics.	This	indicates	that	the	Cary	is	currently	idling	outside	
the	abscissa	range	of	the	baseline	file,	but	that	the	current	method	Start/Stop	
parameters	do	not	exceed	the	abscissa	range	of	the	baseline	

Retrieve	Baseline	File,	Displays	Windows	Open	dialog	box	to	select	a	stored	baseline	
file.	The	spectrum(s)	in	this	file	will	be	used	for	the	selected	baseline	correction.	The	
name	of	the	selected	file	appears	next	to	the	Baseline	button.	

Tip:	If	you	want	to	use	the	baseline	again	with	other	samples,	save	the	method	
using	File	|	Save	Method	As.	Then,	when	you	re-open	the	method,	the	baseline	will	
also	open	and	be	ready	to	use.	All	collection	parameters	are	saved	this	way	and	used		
for	the	new	Scan	runs.	Good	Laboratory	Practice	recommends	use	of	a	new	baseline	
for	each	laboratory	session	View	Baseline	File	Displays	the	spectrum	in	the	
selected	baseline	file.	

Retrieve	Std	Ref	File	Displays	the	Windows	Open	dialog	to	select	a	stored	reference	
file.	The	trace	in	this	file	will	be	used	in	the	Zero	x	Std	Ref	Correction.	The	name	of	the	
selected	file	appears	next	to	the	Std	Ref	button.		

Tip	The	Std	Ref	file	must	be	in	the	valid	format.	You	can	obtain	these	files	from	the	
manufacturer	of	the	standard	that	you	are	using	

• How	to	create	and	use	a	standard	reference	file		
Q.	Why	is	my	Retrieve	Std	Ref	button	unavailable?	
A.	You	need	to	select	the	Correction	type	as	'Zero	*Std.	Ref.	Correction'	
View	Std	Ref	File:	This	displays	the	traces	in	the	selected	standard	reference	file	in	the	
Graphics	area.	

Show	Status	Display:	Select	this	check	box	to	display	the	Show		



15	
	

Status	window.	This	window	allows	you	to	view	the	status	of	various	parameters	
during	the	data	collection.	

Appendix	C	
Graph	menu,	Trace	Preferences	and	Graph	Preferences	options	

1) Graph	menu	options	
Print	XY	point:	cursor's	current	X	and	Y	coordinates	shown	in	the	report	area.	Only	
available	when	right-clicking	in	a	graph	box.	

Trace	Preferences:	choose	the	spectrum	to	display	in	the	selected	graph		
Graph	Preferences:	change	appearance	of	graph;	changes	apply	to	all	graphs.		
Cursor	Mode	enable	use	of	a	free	cursor	that	moves	or	fixed	to	focus	spectrum	(red	
scan).	

Axes	Scales:	change	the	range	of	the	axes.	

Autoscale[XY]:	automatically	scale	X	and	Y	of	spectrum	to	full	screen.	
Autoscale[X]:	automatically	scale	X	width	to	full	screen.	

Autoscale[Y	automatically	scale	Y	height	to	full	screen.	

Zoom	Out:	Zoom	back	to	the	original	X	and	Y	axis	scaling		
Add	Label	enables	placement	of	text	label	on	your	graph.		

Add	Picture	:	insert	a	picture,	bitmap,	or	chemical	structure	into	your	graph.		
Edit	Annotation:	alter	the	content	or	look	of	an	annotation	(such	as	a	label	or	a	
picture).	

Delete	Annotation:	remove	an.	
Single/Multi	Graph	:	toggle	between	displaying	one	or	all	graphs.		

Auto	Arrange	Graphs:	view	and	arrange	all	graphs	simultaneously.	

Copy	Graph:	copy	the	Graphics	area	onto	the	Windows	Clipboard.	
Paste	to	Graph:	paste	the	contents	of	the	Windows	Clipboard	into	the	Graphics	area.		

Add	Graph:	add	a	new	graph	box	to	the	Graphics	area.	
Remove	Graph:	delete	the	selected	graph	box	from	the	Graphics	area.	

Clear	All	Traces:	Select	Clear	All	Traces	to	delete	all	traces	from	the	graph/s.	

User	Data	Form:	display	the	User	Data	Form.	
Maths:	enable	the	Maths	window,	available	when	right-clicking	in	a	graph	box.	

History	List:	displays	a	list	of	the	current	graphs.	
2) Trace	(spectra)	Preferences	Note	that	red	spectrum	is	the	focus	spectrum	and	used	

for	cursor	tracing.	A	single	graph	box	can	display	many	spectra.	Spectra	or	Trace	
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Preferences	are	accessible	from	the	Graph	menu,	by	right-clicking	on	a	trace,	in	the	
toolbar,	or	in	the	spectra	listing	
Visible:	In	single	graph	view,	all	checked	spectra	appear	in	a	single	graph;	in	Multi	
Graph	view,	selects	spectra	appear	in	currently	selected	plot.	
Color:	choose	color	and	line	width	of	the	spectrum.		

Name	of	Spectrum	shows	info	for	spectrum	currently	in	memory.	Right-clicking	in	this	
column	displays	the	Trace	Preferences	menu.		
File	Name:	file	name	and	path	of	the	saved	spectrum.	

Trace	Audit	Log:	information	about	the	last	spectrum	selected.	
Select	Traces:	The	drop-down	arrow	reveals	any	columns	you	have	created	in	the	User	
Data	Form.	You	can	select	traces	based	on	any	of	the	columns	you	have	created.	

3) Graph	Preferences	Used	to	change	the	appearance	of	graph.	Accessible,	by	right-
clicking	on	a	trace	or	by	clicking	Graph	preferences	icon	on	toolbar.		Changes	made	
apply	to	all	graphs.	

Standard	Tab:	alter	the	way	your	graph	appears	on	screen.	
Preview	Box:	preview	of	the	axis’s	variables	shown	to	right	of	dialog	box.	To	change	
the	view,	alter	the	settings	in	the	variables	on	the	left.	

Axes	Color:	select	the	color	that	you	want	to	assign	to	the	axes	of	the	graph(s).	
Axes	Width:	select	the	width	of	the	axes.	The	width	is	between	one	and	five	pixels.	

Grid	Style:	turn	on	or	off	grid	in	graph.		
Plot	Area	Color:	specify	color	of	graph	background.	

Trace	Width:	select	the	width	of	the	spectrum	from	one	and	five	pixels.	

Font:	define	the	font	style	for	the	axes	of	the	graph(s).		
Trace	Style:	define	the	way	that	a	spectrum	will	appear,	points,	line	with	points,	line.	

Advanced	Tab	refine	the	way	your	graph	looks.		
Auto	tick	marks:	alter	the	number	of	tick	marks	on	your	graph.		If	you	have	selected	
the	Major	Ticks	check	box,	this	option	is	unavailable.	

Major	ticks:	number	of	tick	marks	on	each	axis	of	graph.	
Decimals:	number	of	decimal	places	shown	at	tick	marks.	

Show	Legend:	display	a	legend	on	the	right	side	of	each	graph	box.	
A	single	click	on	a	sample	name	or	example	line	within	the	legend	will	make	it	the	
focused	or	red	scan.	Information	about	the	trace	will	be	displayed	below	the	X	axis.		

Double-clicking	the	legend	will	automatically	display	the	Trace	Preferences	
window,	allowing	you	to	view	more	detailed	information	about	your	trace	(e.g.,	
audit	log,	file	name,	etc.).	
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